
Teacher Guide

Lessons for Middle & High School Students: Grades 6 - 9 

Technology Course using 

Google Slides
Explain significance of events. 

In this course, students create a timeline that summarizes significant events. The graphic 

organizer will consist of information organized in chronological order. Each event will be 

analyzed to gain an understanding of its historical importance to people and future events. 

To start, students study sample timelines for inspiration. Next, they research a topic and record 

findings using an organizer. Once the important moments have been pinpointed, Google Slides 

is used to create a graphic display. Upon completion, the sequence of events is shared with 

others. 
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Introduction 

 

Introduction 

 

This section provides valuable information about teaching TechnoTimeline. It 

includes a description of the Teacher Guide, as well as an overview of the 

course. In addition, there are ideas for implementation and technology 

integration.  

 

For additional guidance, open the course in TechnoHub and select Get 

Started to access preparatory steps, resource list, and scheduling timetable. 

TechnoTimeline Overview 

TechnoTimeline Course Outline 

Technology Integration Ideas 
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TechnoTimeline Overview 

 

In this course, students create a timeline that summarizes significant 

events. The graphic organizer will consist of information organized in 

chronological order. Each event will be analyzed to gain an 

understanding of its historical importance to people and future events.  

To start, students study sample timelines for inspiration. Next, they 

research a topic and record findings using an organizer. Once the 

important moments have been pinpointed, Google Slides is used to 

create a graphic display. Upon completion, the sequence of events is 

shared with others. 

 

Students complete the following tasks: 

 

➢ In Session 1, students step into the role of historians as they get ready to construct 

a timeline featuring significant events. To understand the creative possibilities, 

they study samples on a range of topics. These include a renowned inventor, a 

historic expedition, an About Me autobiography, and milestones in flight. Next, 

they select an idea for their own timeline. A list of suggestions aid students in 

identifying a personal area of interest. 

➢ In Session 2, students research their topic to uncover key historical moments. 

These could be firsts, remarkable achievements, milestones, or events that acted 

as catalysts. They use an organizer to record pertinent information, including the 

date and a brief description of each event. An optional activity is available to 

assist students in determining significance. 

➢ In Session 3, students construct a timeline using Google Slides. They start by 

customizing the slide size, allowing for a better display of a series of events. Next, 

they add a title and apply a background to the slide. Then, students use shapes 

with text to sequence dates and events on the timeline. To enhance the visual 

appeal, they experiment with layout and design tools. An optional activity 

introduces drawing tools. 

➢ In Session 4, students explore how to format shapes and online pictures to 

emphasize information in their timeline. They experiment with fill, outline, and 

effects to create a unique design. An optional activity has students explore how 

to crop an image to highlight important moments. 

➢ In Session 5, students collaborate to enhance their timeline. They begin by 

evaluating their own work in terms of design, layout, and content using a 

checklist. After this self-assessment, they partner with a peer, who reviews the 

timeline. The peer editor provides feedback by posting a comment describing 

what they like and offering a suggestion for improvement. Comment starters are 

provided to help students phrase their feedback. This feedback is then used to 

make revisions. 

➢ In Session 6, students share their timeline with others. They can select from three 

options including a slideshow, posted link, or printed document. The assignment 

includes topics for discussion if students present their timeline to a small group. 
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TechnoTimeline Course Outline 
  

Purpose: Create a timeline that forms 

connections between people and events. 
Preparation: 

• Sign up for a Google Account 

• Share Timeline folder with students 

• Download and print Flashcards and Tool 

Summary from TechnoHub (optional) 

 

Objectives: (see Appendix A: Skill Summary) 

• understand the purpose of a timeline 

• research important historical events 

• analyze relative importance of key events  

• organize events using a timeline 

• explain the significance of events 

• customize slide size and layout 

• format slide background 

• insert and format word art 

• draw shapes and text boxes 

• format fill and border of slide objects 

• scale, move, align, and group slide objects 

• copy and paste slide objects 

• join shapes using connectors 

• critically review a timeline to offer feedback 

• post and read comments 

Materials: 

• Sample Timelines: 

Biography, Expedition, Milestones 

• Research Organizer Template (optional) 

• Parent Letter and Certificate (optional) 

• Assessment: 

o Timeline Checklist 

o Peer Review Checklist 

o Timeline Marking Sheet 

o Timeline Skill Summary 

• Flashcards and Tool Summary (optional) 
  

 

Summary of Activities: 

• Gain an understanding of the purpose of a timeline. View samples. 

• Review a list of timeline types. Select a topic. 

• Research an important person or event in history. Summarize findings in an organizer. 

• Use Google Slides to create a Timeline bar using shapes. 

• Use Google Slides to add text boxes describing events. Join the events to the timeline. 

• Review a timeline using a checklist. Make revisions. 

• Peer edit a timeline and offer helpful comments. 

• Share timeline as a presentation, link, or printed document. 

 

Extension Activities: 

• Consider what makes an event significant. 

• Develop graphic skills in a Drawing Workshop. 

•  Explore picture cropping options to illustrate events. 
 

 

Assessment: 

• Self-Evaluation (Timeline Checklist – Assignment 7) 

• Peer-Evaluation (Timeline Checklist and commenting activity – Assignment 8) 

• Teacher Evaluation (Timeline Marking Sheet, Timeline Skill Summary) 
 

 

Notes: 

• If you are a classroom teacher have students build a timeline about a topic they are studying. 

• If you are a computer teacher have students build a timeline about themselves, family, person they 

admire, or topic of personal interest. 

 

https://technohub.technokids.com/
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Technology Integration Ideas 

TechnoTimeline integrates into curriculum. This course can be used to identify significant events, 

develop an understanding of a historical period, study changes over time, or analyze causal 

relationships. Students can create a timeline on a wide range of topics. You may wish to include 

course activities as part of a history, social studies, or language arts unit. Below are some 

suggestions: 

 

• Autobiography Timeline: Tell about yourself. What makes you special? Share milestones 

or achievements in your life. Explain why each event is important to who you are today. 

This timeline will span from birth to present day. 

• Family Timeline: Record special memories. When did family members marry, have a 

baby, move, go to college, or get a job? Describe how this influences you today. 

• Biography Timeline: Select a significant historical figure such as a politician, explorer, 

scientist, or humanitarian. What decisions or accomplishments were influential? Form 

connections between people and events. This timeline will span a lifetime. 

• Historical Period Timeline: Select a historical period such as the age of imperialism, 

ancient civilizations, renaissance, or middle ages. What critical developments shaped 

the future? This timeline may span several decades or centuries. 

• Historical Event Timeline: Select a historical event such as a war, revolution, or expedition. 

What challenges were overcome to produce a particular result? Pinpoint important 

events. This timeline may span several years or decades.  

• Historical Topic Timeline: Select a topic such as flight, country, or scientific advances. 

What stands out as being important? Outline critical moments from the beginning to 

today to show changes over time. This timeline may span years, decades, or centuries. 

• Historical Moment Timeline: Select a significant moment or situation such as an invention, 

discovery, human rights issue, vote, or disaster. What led to it? Analyze the cause and 

consequences of each event. This timeline may span several years or just one day.  

• Plot Summary Timeline: Select a novel. What happened? Sequence the story events. This 

timeline will span from the beginning to the end of the book. 

 

Understand the Big Picture 

 

Not sure where to integrate TechnoTimeline? There are three samples provided for this course. 

These samples provide ideas on how you can include these activities in the curriculum. 

✓ Biography - Alexander Graham Bell's contribution to technology 

✓ Expedition – the challenges overcome by Sir Ernest Shackleton’s crew during the Imperial 

Trans-Antarctic Expedition 

✓ Milestones – significant events in the era of manned flight that show changes over time 

 

 



 

 

 

Session 1 What is a Timeline? 

 

Session 1 

What is a Timeline? 

In this session, students step into the role of historians as they get ready to 

construct a timeline featuring significant events. To understand the creative 

possibilities, they study samples on a range of topics. These include a 

renowned inventor, a historic expedition, an About Me autobiography, and 

milestones in flight. Next, they select an idea for their own timeline. A list of 

suggestions aid students in identifying a personal area of interest. 

Assignment 1: What Is a Timeline? 

Assignment 2: Brainstorm a Topic 
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Assignment 1: What Is a Timeline? 

 
 

What Is a Timeline? 

 

A timeline is a summary of events that happened in history. These events are sequenced in the 

order they occurred. Events are arranged chronologically along a line from earliest to latest. The 

passage of time illustrated may be a day, year, decade, or century. The timeline may include 

text, pictures, or both. 

 

The line is shown as a long bar labelled with dates. Along the line are points in time that mark an 

important event. These are placed proportionally along the line to show the passage of time 

using a linear scale. The distance along the line equals a set amount of time. 

 

Events marked along the timeline are significant. This means that they are worthy of attention. 

They may mark a milestone, outline an achievement or accomplishment, hold special meaning, 

or have influenced history. 

 

 
 

Why Use a Timeline? 

 

A timeline can be used to: 

• highlight important achievements or milestones in a person's lifetime 

• form connections between people and future events 

• develop an understanding of a historical period 

• study changes over time 

• analyze the cause and consequences of events 

 

  

In this course, you are going to organize a series of 

important events into a timeline using Google Slides.  

 

To prepare for this activity, study sample timelines to 

gain ideas about how you can creatively sequence 

significant moments. 
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Study Timelines 

 Open the Timeline folder.  

 View each sample and answer the questions. 

 

 
Biography 

1. Why was the year 1876 chosen as an important event? 

 The telephone changed how people communicate. 

  

2. Why was the fact about Bell’s father included? 

 Bell’s father helped the deaf, sparking his son’s interest 

 in helping and teaching deaf people.  

 

 

 

 
Expedition 

3. Why are the shapes representing 1915 and 1916 shorter 

than 1914 and 1917? 

 There are 3 important events in each year 1915 and  

 1916. They show a shorter time period. 

4. Why are the months included as well as the years? 

 There is more than one event in the year. The month 

 is needed to show when the event happened.  

 

 

 

 
Milestones 

5. Why was this timeline made over two slides? 

 There are a large number of important events in the  

 topic. 

  

6. What do you think the next milestone in flight in the 

future will be?  

  

 

 

7. What are the benefits to using a timeline to learn about a topic? 

  

  

  

 

 

Get ideas for making 

your own timeline. What 

designs do you like? 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 



 

 

 

Session 3 Place Events in Chronological Order 

 

Session 3 

Place Events in 
Chronological Order 

In this session, students construct a timeline using Google Slides. They start by 

customizing the slide size, allowing for a better display of a series of events. 

Next, they add a title and apply a background to the slide. Then, students use 

shapes with text to sequence dates and events on the timeline. To enhance 

the visual appeal, they experiment with layout and design tools. An optional 

activity introduces the drawing tools. 

Assignment 4: Create a Timeline 

Assignment 5: List Events and Connect to the Timeline 

 

Session 3 Extension Activity: Drawing Workshop 

 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Assignment 5: List Events and Connect to the Timeline 

In this assignment, you use your research from Assignment 3 to 

add events and connect them to the timeline. For each event 

describe what happened and why it is important. You will:  
 

✓ describe an important event using a text box 

✓ copy and paste the text box and edit the information 

✓ connect each event box to the timeline using a 

connector line 

 

Log Into Google Drive and Open the Timeline Presentation 

 

Add an Event Text Box 

 Click Text box.  

 Click and drag to draw a text box on the slide. 

 Type the event description into the text box. 

 Format the font , size , and style  of the text. 

 

 Use your skills to format the shape fill , border color , and border weight.  

 
 

Copy Text Box and Paste It to Add Remaining Events 

 Click on the text box to select it. 

 From the Edit menu, choose Copy.  

 From the Edit menu, choose Paste.  

 Move the text box into the next position on the timeline. 

 Replace the event description with the second event. 

 Use your skills to add remaining events. 

  

Name of event. Describe the significance. Is it a milestone or the first time it has 

happened? Is it a remarkable achievement? Is it important to this time period? 

Does it cause another event to happen? 

TechnoChallenge: Create a see-through effect to show the background behind a text box. Click Fill 

color. Select Custom. Drag the transparency slider to the LEFT to increase transparency. Click OK. 
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Draw Connectors to Join Each Event to a Date 

 

 

 Click the Select line arrow.  

Pick Elbow Connector.  

 

 

 

 Connect the date to the event:  

o Rest the crosshair over the first date on the timeline.  

o Click on the center handle to anchor the line to the date. 

o Click and drag the connector to the corresponding text box.  

Click on a handle to anchor the line to the event. 

 Use your skills to connect the other dates to events. 

 
 

Format the Connectors 

 Select a connector. 

 Use your skills to format the Line color  and Line weight.  

 Click Line start.  

Choose an option.  

 Click Line end.  

Choose an option.  

 

 

 

 
 

Log Out from Google Drive 

You need to join each event to the 

correct date. You will use an Elbow 

Connector to join a shape to a text box.  

TechnoChallenge: Copy the formatting from one connector to another. Select a connector 

you like. Double click Paint format.   Click every other connector to make them all look the 

same. Click Paint format again to turn it off. 

Drag the adjustment 

handle to change the 

bend in the line. 
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Session 3 Extension Activity: Drawing Workshop 

If you are new to Google Workspace, you may want to explore the drawing 

tools before you begin to make a timeline. Knowing what you can create 

and how to make it will help you to design a unique timeline that is clear and 

easy for viewers to understand. 

 

1. Log into Google Drive. Click New  and select Google Slides.  

2. Click Layout  and choose Blank.  

 

3. Draw a shape: 

 
a. 

Click Shape.  

Pick a category and choose a shape. 

  

 

 b. Click and drag to draw a shape on the slide. 

 

4. Explore how to size, move, rotate, and distort the shape: 

  

    
  Drag a corner handle 

to resize the shape. 

Drag the shape to 

move it on the slide. 

Drag the circle handle 

to rotate the shape. 

Drag the diamond to 

bend a shape. 

  
Note: Not all shapes can be distorted. 

 

5. Select the shape. Explore formatting tools to change the way the shape looks:  

     
 Click Fill color.   

Pick a color from the 

palette. 

Click Border color. Pick 

a color from the palette. 

Click Border weight. 

Pick a width from the list. 

Click Border dash. 

Pick a style from the list. 

 

 
  

You can change the shape but keep the formatting.  
 

Right click on the shape and pick Change shape.  Pick a new shape from the gallery. 
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6. Add text to a shape: 

 a. Right click on the shape and select Edit text.  

 b. Type the year you were born. 

 c. Click and drag to select the text. 

 d. Explore the tools to change the look of the text: 

      
  Click Font.  

Pick a typeface. 

Click Font size.  

Pick an option, type a 

number into the box,  

click - to make the text 

smaller, or click + to make 

the text bigger 

Click Text color.  

Pick  a color from the 

palette. 

Click Align.  

Pick an alignmnent 

option. 

 

7. Arrange objects: 

 a. Right click the shape and select Copy.  

 b. Click anywhere on the slide, right click, and select Paste.  

 c. Paste the object again to make three shapes. Edit the text in each shape. 

 d. Drag the objects until red guidelines appear to align the shapes. 

 

 
  Note: If the guidelines do not appear, from the View menu select Snap to – Guides. 

 

8. Distribute the shapes evenly and group objects: 

 a. Click and drag around the shapes to select them all. 

 

 

 b. From the Arrange menu, click Distribute.  Select Horizontally.  

 c. With all the shapes selected from the Arrange menu, select Group.  

 d. From the Arrange menu, click Center on page.  Select Horizontally. 

 

 

Have fun with shapes! 

Can you draw a red heart with the word LOVE inside? 

Can you draw a yellow arrow with a blue outline? 

Can you draw a callout bubble? 

 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 



 

 

 

Session 5 Gain Peer Feedback 

 

Session 5 

Gain Peer Feedback 

In this session, students collaborate to enhance their timeline. They begin by 

evaluating their own work in terms of design, layout, and content using a 

checklist. After this self-assessment, they partner with a peer, who reviews the 

timeline. The peer editor provides feedback by posting a comment describing 

what they like and offering a suggestion for improvement. Comment starters 

are provided to help students phrase their feedback. This feedback is then 

used to make revisions. 

Assignment 7: Use a Checklist to Edit the Timeline 

Assignment 8: Share Your Timeline to Get Feedback  
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Assignment 7: Use a Checklist to Edit the Timeline 

Is the timeline finished? Use the checklist to review your work. 

 

Timeline Checklist ✓ 

Background color or picture suits the topic.   

Title is created in Word art and has been formatted to be eye-catching.  

Timeline bar is labelled with dates and looks attractive.  

The size of each shape in the timeline bar varies to show the amount of time.  

There are a suitable number of timeline events.  

Events describe important facts about the topic.  

Event text boxes are formatted to look attractive, and text is easy to read.  

Connector lines link events to the correct dates in the timeline.  

Spelling and grammar are correct.  

All timeline objects have been arranged to create a balanced layout.  

 

 
 

 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 



 

 

 

Appendices 

 

Appendices 

 

Refer to the appendices for additional resources: 

Appendix A: Assessment Tools 

Appendix B: Contact Information 

 



 

 

This is a preview of the teacher guide. 
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Appendix A: Assessment Tools 

Timeline Marking Sheet 

 

Background color or picture suits the topic.  
/1 

Title is created in Word Art and has been formatted to be eye-catching. 
/1 

Timeline bar is labelled with dates and looks attractive. 
/2 

The size of each shape in the timeline bar varies to show the amount of time. 
/2 

There are a suitable number of timeline events. 
/2 

Events describe important facts about the topic. 
/10 

Event text boxes are formatted to look attractive, and text is easy to read. 
/3 

Connector lines link events to the correct dates in the timeline. 
/1 

Spelling and grammar are correct. 
/1 

All timeline objects have been arranged to create a balanced layout. 
/2 

 /25 

  



 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

This course includes a sample of a completed project. 
Teachers can use this resource for demonstration purposes 

or as a source of inspiration. 

 

 

 

 

 

 



Tests First Telephone
Alexander's patent for the Acoustic 
Telegraph was approved. The idea would 
later develop into the telephone. This 
device changed how people communicate.

Born in Edinburgh, Scotland
Alexander's family influenced his 
life. His mother was deaf. His 
father invented a system of 
symbols to help the deaf to speak.

Opens a School for the Deaf
Alexander opened the School of Vocal Physiology and Mechanics of 
Speech in Boston improving on the system his father invented. He 
helped many children communicate including Helen Keller.

First Passenger Flight in Canada
Alexander led the Aerial Experiment 
Association. This research group 
produces several aircraft including the 
Silver Dart. It flew the first passenger 
flight in Canada. Today, people travel 
every day in commercial airplanes.

Invents Metal Detector
An assassination attempt on the American President left a bullet in his 
body. Alexander worked with Simon Newcomb to create a metal 
detector. Although, it did not help the President, the idea would later 
be improved upon to create modern detectors.

1847 1872 1876 1881 1909 1922

Dies in Nova Scotia, Canada
Alexander's improved the world. 
His inventions shaped the future 
of telecommunications, medical 
devices, aircraft design, and 
alternative fuels. 



Although the expedition fails it 
is a remarkable survival story!

August
1914

January
1917

January
1915

May
1915

October
1915

April
1916

May
1916

August
1916

Shackleton planned to be 
the first to walk across the 
Antarctic. The land was 
unexplored and he planned 
to study the area. His ship, 
the Endurance set sail.

Shackleton's ship becomes trapped 
in ice on the Weddell Sea. His men 
are stranded at sea. The pressure 
from the ice starts to crush the ship. 

More misfortune! The supply ship, Aurora is adrift. Shackleton had planned to 
have a ship drop off supplies along his route.  The Aurora crew had set up a base at 
Cape Evans.  In May, a storm causes the ship to break loose from its moorings with 
men on board. This leaves the crew stranded at Cape Evans and the ship adrift. 
Without a way to contact Shackleton, they continue their mission. However, 
Shackleton never uses the supplies they drop off because his ship is stuck.

Shackleton abandons ship 
when the stern is crushed. 
The men take three boats and 
set up camp on an ice floe with 
limited supplies. They live in 
Ocean Camp for some time, but 
eventually, the ice starts to melt.

Shackleton lands 
on the wrong side 
of the island. He 
takes two men and 
they walk for three 
days across miles 
of dangerous 
terrain to reach the 
whaling station.

Shackleton rescues his crew 
from Cape Evans. Shackleton 
sails on the now repaired 
Aurora to pick up his men.

Shackleton rescues his 
crew on Elephant Island. 
He had tried several times 
before and failed. However, 
he finally reaches them on 
the steamer Yelcho. The 
men had lived for months 
using two upturned boats for 
shelter. Shackleton heads 
towards New Zealand.

The Aurora is towed to New 
Zealand. After a year adrift at 
sea the small crew that was 
stranded on the ship is saved.

Shackleton goes in 
search of help!  His 
crew sail their boats 
to Elephant Island. 
The island is remote 
and many men are ill. 
Shackleton decides 
to take a small team 
and sail to South 
Georgia where there 
is a whaling station.



1783 1900 1903 1927 1940 1947 19521939

Montgolfier Brothers
First hot air balloon 
flight

Zeppelin Airship
First successful rigid airship flight

Wright Flyer
First heavier-than-air, powered, 
manned, controlled flight

Spirit of St. Louis
First solo transatlantic flight

Heinkel He 178
First jet aircraft

Sikorsky VS-300 
First successful manned 
helicopter

Bell X-1
First airplane to fly faster than the 
speed of sound

De Havilland Comet
First jetliner passenger 
service



1969 1976 1981 2000 2006 20211986

Yuri Gagarin
First man to journey 
into outer space and 
orbit earth

Apollo 11
First man on the moon

Viking Mars Lander 
First landing on Mars

Shuttle Columbia 
First reusable spacecraft

Voyager
First nonstop flight around the 
world without refueling

International Space Station
First crew takes up residence

Unmanned Aerial Vehicles
US Federal Aviation Administration 
authorizes use of drones for search and 
rescue

Space Tourism
SpaceShipTwo and New 
Shepard each take 4 
passengers

1961
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